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I. Ichimoku waves meter — Preface. 

 Ichimoku waves meter is a graphic program that allows you too quickly and easily measure the proportions 

between indicated points on the price chart. This price and time range indicator is the basic tool for chart analysis 

according to Ichimoku's strategy on the MT4/5 platform. With the help of this tool, insightful and complete analysis of 

time waves as well as price waves becomes possible in a short time, and the effort put into performing the analysis is 

minimised many times compared to a similar one, carried out using the existing measurement and calculation tools in 

an Excel spreadsheet. The indicator was designed using the knowledge and experience of traders using the Ichimoku 

kinkōhyō strategy, as well as taking into account their expectations, resulting in the presented tool. 

 The modular structure of the indicator means that we carry out the necessary analysis in a logical order, starting 

with collecting measurements on the waves that are made, which are data for calculating forecast market movements 

in the future. The data, taken into account in the calculation of forecasts, are key to the accuracy of the scenario, which 

in the case of the presented indicator is a minimised activity, giving immediate measurement displayed in a graphical 

form on a candle chart, which can be personalised in many planes. The result can be presented as information on the 

chart in the form of a calculated value, e.g. pips number of candles or date of the forecast change in the market. 

 The construction of the indicator allows you to work on the basis of time theory as well as prices at the same 

time, thanks to which we get a picture confirming the convergence of waves, which confirms the accuracy of the 

analysis, as well as we can hide graphic or numerical information that is not of interest to us at the moment. The 

indicator uses Hosoda numerical values, which when recognised on the graph accentuates by graphic distinction, 

depending on the degree of approach to the basic numerical values, which allows the analyst to quickly draw attention 

The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.
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to the emerging market situation or indicate the degree of implementation of the assumed scenario. The tool for 

calculating the forecasted market ranges uses the basic formulas for time wave movements as well as the prices 

derived by Hosoda, which results in forecast ranges, from the nearest to possibly further and further implemented 

ranges in a very precise range. 

 The work on the chart, where, apart from cycles with basic numerical values, there are also equivalent values, 

kakugi or jugi, is facilitated by a panel for automatic current measurements. When assessing the situation, we can also 

use the panel for manual measurements. The basic schemes of the theory of coverage V, N, E, NT are also 

supplemented with Habitual, Denying and average ranges, and with high dynamics of movement multiple of range like 

2E, 3E. In addition to the presented basic functions necessary to carry out the analysis according to Ichimoku strategy, 

the indicator is equipped with additional functions, such as analysis of candle closures from a given period and 

presentation of the result of such measurement in a graphical form of so-called Kyushu legs. By analysing the cyclical 

nature of the market, you can also use the mirror image function. 

 We invite you to familiarise yourself with the detailed functionality and capabilities of the indicator 

described below. At the same time we wish you good analyses using the Ichimoku waves meter and 

fruitful operations. !  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II.Ichimoku waves meter — System requirements. 

Required font installation: „Webdings”. 

III.Ichimoku waves meter — Installing the indicator and the template on the MT5 platform. 

1. Installing for the Windows systems. 

 Install the „Ichimoku waves meter en.ex5” file that you’ve received from the dealer into the: MQL5/
Indicators/ catalogue (applies to desktop version). 

 Instal the „ichi_clean_All_TF.tpl” file into the MQL5/Profiles/Templates catalogue. 

First, you need to "  open the MT5 platform; #  verify if it has been logged in the suitable trading account (the 
trading account ID for which you’ve bought the IWM desktop license). Next $  choose the File tab on the left 
side of the upper menu bar. Finally, %  choose Open Data Folder from the File tab menu. 
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For the next step, &  open the MQL5 folder. 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+  Open the Templates folder. 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" "  Place (copy and paste) the „Ichi_clean_All_TF.tpl” file that you’ve received from the dealer in the 
Templates folder. 

 z 10 175
The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/


www.ichimoku.eu

The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

" #  Close the active window and " $  restart the MT5 platform (close and re-open the program). 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2. Installing for the macOS systems. 

 Before installing the Ichimoku waves meter indicator to facilitate the installation, create a new folder on 
your desktop, name it "MT5" for example. Move the files you received from the vendor: 
„Ichimoku waves meter en.ex5” and „ichi_clean_All_TF.tpl” from the "Downloads" folder to the newly 
created folder on your desktop named "MT5". 

 z 12 175
The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

..grab, drag and drop
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 Open the MT5 platform, "  select the View tab. #  Chose the Navigator tab from the menu and $  confirm 
with a single click (left mouse button). 

 Ok now you have to %  verify if it has been logged in the suitable trading account (the trading account ID for 
which you’ve bought the IWM desktop license). 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 In this step, we will apply and save a dedicated template „ichi_clean_All_TF.tpl”.  

&  Right-click on the chart window. A pop-up menu will open. '  Select Templates and then Load Template and 
confirm by clicking the left mouse button. 

 z 14 175
The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/


www.ichimoku.eu

The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

 Point to the path of the template file you purchased: (  Select My Mac Desktop. )  Navigate to the file you 
created on your desktop named MT5. Then *  select the file called „ichi_clean_All_TF.tpl” and press Open. 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 Save the template and give it your name. " ,  Right-click on the chart window. A pop-up menu will open. 
'  Select Templates and then Save Template and confirm by clicking the left mouse button. 

" "  Now give it its own name. For example "Ichimoku_1" and " #  confirm by pressing Save.  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 In this step we will add the purchased indicator „Ichimoku waves meter en.ex5” to the list of indicators. 

" $  Choose the File tab on the left side of the upper menu bar. Finally, " %  choose Open Data Folder from the 
File tab menu. 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Here we see Folders from MetaTrader5… 

 From the menu tree on the left, " &  select My Mac Desktop. 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" '  Navigate to the file you created on your desktop named MT5. Then " (  select the file called 
„Ichimoku waves meter en.ex5” and " )  press on its name with the right mouse button. Then in the pop-
up menu " *  select Open and wait a moment. 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After a while, you will see the Ichimoku waves meter indicator listed (in the menu tree) in the Navigator 
menu. From this point on it will be available in the Navigator. 

 z 20 175
The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/


www.ichimoku.eu

The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

IV.Ichimoku waves meter — Essential info. 

1. Starting the indicator. 

 First, after installing the template and the indicator on to the MT5 platform (according to point III of this 
manual), every time after choosing a walor — which means opening a new window instrument of the feature 
that is to be analysed — you need to apply the template that you’ve received from the dealer. This action is not 
obligatory. The template, however, had been prepared in the dark mode that harmonises with the default 
colours of the Ichimoku waves meter tool in concern of the user. 

Applying the ichi_clean_All_TF. 

 To apply the previously saved template on the chart from the open MT5 platform level you need to 
"  choose the Charts tab, next #  choose Template from the list and then $  the ichi_clean_All_TF 
(Ichimoku_1) file which you want to open by pointing it with the cursor. Confirm by clicking the name of the 
chosen template once with the left key of your mouse.You can also load a saved template by opening the popup 
menu. Click the right mouse button on the chart window and select the saved template. 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In the top picture — the way of accessing the templates list by the menu; in the bottom picture — access from 
the pop-up menu. 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Template: ichi_clean_All_TF / visualisation. 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Applying the Ichimoku waves meter indicator on the chart window. 

 To apply the previously saved indicator on the chart from the open MT5 platform level you need to 
"  choose the Insert tab, then #  choose Indicators from the list, $  choose Custom > from the sublist and then 
%  the Ichimoku waves meter en file which you want to open by pointing it with the cursor. &  Confirm by 
clicking the name of the chosen indicator once with the left key of your mouse. 

 z 24 175
The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/


www.ichimoku.eu

The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

 To apply an indicator to a chart, you can also drag and drop it from the Navigator pop-up menu. To do this: 
"  Open the View tab. #  Select the Navigator tab from the menu and $  confirm with a single click (left mouse 
button). Then $  select the Ichimoku waves meter from the navigator menu by clicking on its name with the 
right mouse button. %  Select Attach to Chard and confirm by left-clicking. You can also plot the 
Ichimoku waves meter indicator on the chart window by grabbing it, dragging and dropping on the chart.  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…or grab, drag and drop
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After choosing the indicator, the program info window will appear on the screen. Here you can immediately 
confirm applying the indicator (with default settings values) by pressing the OK button — the indicator will be 
applied onto the chart. You can also draw the settings menu forth by clicking the Inputs button with the left key 
of your mouse. You need to use this option when you want to individually personalise the indicator or double 
the tool (described below in point 2).  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Ichimoku waves meter program applied to the chart / visualisation. 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2. Using Ichimoku waves meter. 

Unique number identifying the Ichimoku waves meter indicator, so-called „Magic number”. 

 When you apply the indicator onto the chart (described in point 1), the program info window appears. From 
this level you can access the settings menu (the Inputs button), where the „01_Set a unique number (Magic) 
identifying the indicator” parameter is the most important parameter, allowing the indicator to distinguish the 
measurements performed with the same tool opened multiple times on different windows within one or many 
profiles; the MT5 program does not distinguish a profile from a window! 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 Therefore, if we want to have a few windows with the same tool (e.g. different time intervals, etc.) 
opened while analysing different features and e.g. we want to apply the Ichimoku waves meter indicator 
onto a few of them, to make it work properly, it’s essential for the program to be able to distinguish windows 
with the same feature. That’s why it’s crucial to enter for every window (with a doubled tool) an additional 
variable that allows to distinguish the indicator between these windows, so-called „Magic number” set 
individually. To do this, when applying the indicator onto the chart, you need to choose the Inputs tab and 
change parameter no.1 from the number that had previously been assigned in the opened windows with the 
same tool. 1 is the defaulted assigned value; the possible range in which the number can vary is 2 to 99. If, by 
mistake, we assign an already existing number and confirm it with the OK button, the program will ask us to 
confirm or cancel the choice by displaying an info window with the selection options before it applies itself onto 
the chart. Here we can confirm or cancel (give up). Moreover, if we had previously opened a chart with 
a chosen feature (there had been an IWM indicator applied onto it) and it has been closed (deleted, etc.), while 
re-opening the same tool and re-applying the IWM onto it, the same info notice with the selection options can 
also be displayed, depending on how the tool has been closed (deleted) before.  

 z 29 175
The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/
https://ichimoku.eu/en/


www.ichimoku.eu

The information and data contained are the exclusive property of Ichimoku Ltd. Any use and publication, if not authorised by Ichimoku Ltd, are prohibited by law. Any person access in the information contained here, even if authorised, is committed to strict confidentiality.

The template and saving the indicator within it… 

 When working with charts, saving frequently used indicator/(-s) into the template we apply onto the chart 
seems to be making things easier — in theory, it shortens the pre-work preparations. This is what analysts or 
traders do pretty often. However, this methodology turns out wrong — it may cause the indicators work 
incorrectly, including miscalculations and multiple displaying the same graphic elements. Hence, it’s best to 
apply a plain template first and then subsequently apply indicator/(-s) every time you open a new 
chart window.  

This rule refers not only to Ichimoku waves meter, but it should be considered as general. Along with the 
IWM program, the dealer had delivered a plain ichi_clean_All_TF.tpl template, and we strongly recommend 
using it. 

When does the Ichimoku waves meter program do the calculations? 

 Ichimoku waves meter basically does the calculations within the currently active (in-use) window so as 
not to put a strain on the computer’s processor when not necessary. The calculations happen every bar, every 
tick and every set time [ms] and when activating a window (if the IWM has been applied onto this window 
previously). Therefore, if we have a few small windows opened at the same time on the graphic, the updates 
will be done only on the currently active sheet (along with the  candles progress / ticks, etc.). The other 
windows will be in snooze mode. After changing windows, the newly chosen one will become updated, and the 
previous (deactivated) one will go into snooze mode. The only exception is counting the „Kyushu legs”, where 
the bar calculation update happens every tick for all the sheets displayed at the same time. This, however, is 
insignificant when working in the full screen mode — one chart sheet. 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A few small sheets on one graphic with the „Kyushu legs” applied — the update happens every tick in all of the 
windows.  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Deleting the chart window and Ichimoku waves meter. 

 If you want to delete (close) an unnecessary chart window with the Ichimoku waves meter applied, 
it’s best to first apply a plain template onto a sheet and then close (delete) the chart window. This action is not 
obligatory. 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3. Default settings of the indicator parameters. 

 To open the indicator settings menu, you need to "  do it from the opened MT5 platform level. #  Choose 
the Charts tab, then $  open the Indicators List or use the Ctrl + I shortcut. Next, %  choose 
Ichimoku waves meter en from the indicators list (by quickly double clicking on the indicator’s name with 
the left key of your mouse or clicking once on the indicator’s name with the left key of your mouse and then 
confirming the choice with clicking on the Properties icon  with the left key of your mouse. On the screen there 
will appear the indicator window and so will its tabs (Common, Inputs, Colours, Visualization). You’ll need to 
&  choose the Inputs tab — the indicator settings menu will be displayed on the screen. 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Below you have the indicator settings menu; the marked settings parameter is the most important one — 
„Magic number”. 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In the right column you can individually personalise every parameter whenever needed. The configuration can 
be saved using the Save button. When re-applying the indicator, the configuration can be used by pressing the 
Load button. 

You can confirm the changes by pressing the OK button, cancel them by pressing the Cancel button or return to 
the default settings by pressing the Reset button. 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4. Closing the MT5 platform on the macOS computers. 

Saving the applied measurements and closing the MT5 program correctly on the macOS computers. 

 When we want the measurements that we’ve applied onto the chart to be saved so that we can continue 
working on them when we’ll open the MT5 platform again, we have to exit the app using by closing the 
window with the red dot  used for closing the program window. If we do that, all the changes will be saved.  

On the other hand, if we exit the MT5 app installed on the MAC computer by choosing the QUIT function (from 
the head bar level) or by choosing the FINISH / QUIT function (from the Dock level), the performed 
measurements will not be saved. When exiting in such a way, all the changes (not only the measurements, but 
also visibility of the windows, buttons, etc.) applied onto the MT5 are cancelled just as it’ll happen if we choose 
the CANCEL button.  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V. Ichimoku waves meter — buttons and indicator functions panel / graphic division. 

1. Main menu panel — it enables the selection of the functional modules. 

2. Functional modules. 

2.1. „DHR” — price Habitual Ranges manual and automatic measurement panel. 

2.2. „AcM” — Automatic Current ABC Measurement (of impulse and correction); of change time and 

price movement potential ranges projection; of allocating possible D points. 
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2.3. „AhM” — Automatic Historical ABCD Measurement (of the performed N, Y, P, S wave); of verifying 

the existing relations. 

2.4. „MM” — Manual AB Measurement / single impulses and corrections measurement. 

2.5. C from ABD — panel of allocating the price Habitual Ranges (Denying and Habitual) measured 

from the measurement point A and the possible Correction Deepness based on point A, B and 

hypothetical level D. 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 Along with the acquisition of rights to the 
perpetual license for the Ichimoku waves 
meter program, an extended user's manual 
will be added as well.
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